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Workshop
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● Python-Entwicklungsumgebungen:
– Spyder
– Jupyter

● Branchensoftware mit Python-Schnittstelle:
– Blender
– optional: FreeCAD

● CAMPLA/Lernstick

Workshop-Themen
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Spyder
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Python-Entwicklungsumgebung
Zur Erstellung von Python-Programmen genügen eigentlich einfache Texteditoren, wie wir sie schon kennengelernt haben, z.B. vi, nano oder 
gedit. Ein deutlich höheres Komfort-Level und erweiterte Möglichkeiten bieten jedoch so genannte «Integrierte Entwicklungsumgebungen», die 
dann schon bei der Eingabe des Python-Quelltextes Fehler erkennen oder automatische Vervollständigungen anbieten.

Eine relativ einfache Python-Entwicklungsumgebung ist die «Spyder IDE», siehe https://www.spyder-ide.org.

In der Lernumgebung können Sie einfach das 
Softwarepaket spyder3 nach-installieren.

Starten Sie dann das Programm via 
Desktopumgebung (Dock → Anwendungen 
anzeigen), ignorieren eventuelle Hinweise zu 
Updates und stellen die Sprache via «Tools → 
Preferences → General → Advanced Settings» 
auf Deutsch um.

Unter Windows und macOS laden Sie das 
Installationsprogramm von folgender Seite 
herunter:

https://github.com/spyder-ide/spyder/releases

https://www.spyder-ide.org/
https://github.com/spyder-ide/spyder/releases
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Jupyter-Einführung
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JupyterLab via Python-Standardinstallation (Windows)

1) Startmenü ▸ Windows-System ▸ Eingabeaufforderung starten und den Befehl
pip install jupyterlab eingeben.

2) Zum Starten von Jupyterlab kann der Befehl jupyter-lab eingegeben werden.
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JupyterLab via Python-Standardinstallation (macOS)

1) Im Finder Programme ▸ Dienstprogramme ▸ Terminal starten und den Befehl
pip3 install jupyterlab eingeben.

2) Zum Starten von Jupyterlab kann der Befehl jupyter-lab eingegeben werden.
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JupyterLab via Python-Standardinstallation (Linux)

In der Lernumgebung kann JupyterLab via Kommandozeile wie folgt installiert 
werden:

sudo apt install python3-pip

sudo pip3 install jupyterlab

Der Start erfolgt dann durch die Eingabe des Befehls:

jupyter-lab
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JupyterLab via Anaconda

1) das Installationsprogramm 
herunterladen

2) das Installationsprogramm starten

3) die Installation und unter 
Beibehaltung aller 
Voreinstellungen durchführen
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JupyterLab via Anaconda

1) über das Startmenü
«Anaconda Navigator» starten

2) JupyterLab starten
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JupyterLab

● moderne, flexible und modulare 
Benutzeroberfläche

● Bearbeitung von Jupyter-Notebooks 
und vielen weiteren Dateiformaten

● Zusammenstellung und Konfiguration 
von Data-Science-Workflows
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JupyterLab: Menü

Das Menü beinhaltet die wichtigsten Einträge zu:
● Dateioperationen
● Bearbeitung von Dokumenten
● Anpassung des Aussehens von JupyterLab
● Ausführung von verschiedenen Zellen
● Verwaltung von verschiedenen Kerneln
● Wechseln zwischen verschiedenen Dokumenten 

und Aktivitäten
● Einstellungen
● Hilfe

JupyterLab-Erweiterungen können das Menü um 
weitere Einträge ergänzen (z. B. im Screenshot 
der Eintrag «Share» ganz rechts).
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JupyterLab: Seitenleiste

In der Seitenleiste befindet sich:

● ein Dateibrowser

● eine Übersicht über alle Dokumente, Kernel und 
Terminals

● ein Inhaltsverzeichnis zur schnellen Navigation 
durch ein Jupyter-Notebook

● die Verwaltung der JupyterLab-Erweiterungen

Die Seitenleiste kann durch Anklicken der Icons 
auf der linken Seite auf- und zugeklappt werden.
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JupyterLab: Arbeitsbereich

Im Arbeitsbereich werden
● alle geöffneten Dokumente (Notebooks, 

Textdateien, Bilder, ...)
● Terminals
● Konsolen

... in sogenannten «Tabs» dargestellt, die sehr 
flexibel per Drag & Drop oder Kontextmenüs 
(rechte Maustaste) umsortiert, geteilt und 
angeordnet werden können.
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JupyterLab: Arbeiten innerhalb eines Notebooks
https://jupyterlab.readthedocs.io/en/stable/user/notebook.html

● Neues Notebook anlegen

● Zellen
– erzeugen
– navigieren mit Pfeiltasten
– kopieren (c), ausschneiden (x), einfügen (v)
– auf- und zuklappen
– per Drag & Drop umsortieren
– per Drag & Drop in andere Notebooks kopieren

● synchronisierte Ansichten des gleichen Dokuments erzeugen

● synchronisierte Ansichten für Ausgaben von Zellen erzeugen

https://jupyterlab.readthedocs.io/en/stable/user/notebook.html
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Markdown-Zellen
Wenn neue Zellen angelegt werden, sind sie per Voreinstellung «Code-Zellen». Das sind Zellen, in denen 
Programmcode abgelegt wird, der durch den zugehörigen Kernel (z.B. Python) ausgeführt werden kann.

Für reichhaltig formatierte Kommentare und Erklärungen können in einem Jupyter-Notebook 
sogenannte «Markdown-Zellen» verwendet werden.

Der Typ einer jeden Zelle kann über das Dropdown-Menü am oberen Rand eines jeden Notebooks 
umgestellt werden:

(Zellen vom Typ «Raw» werden von Jupyter-Notebooks gar nicht ausgewertet. Sie können für besondere Wünsche beim Exportieren 
von Notebooks in andere Formate verwendet werden, was wir jedoch hier nicht weiter betrachten werden.)



Berner Fachhochschule | Haute école spécialisée bernoise | Bern University of Applied Sciences                                           64

Markdown-Zellen

Aufgabe:

Ändern Sie den Typ einer Zelle auf Markdown und fügen Sie einen einfachen, jedoch mit Markdown 
formatierten, Text ein (siehe Wikipedia-Artikel oder Beispiele auf nächster Folie).

Eine Zelle lässt sich unter anderem mit dem Play-Icon (siehe Pfeil ▸ im Screenshot oben), über das Play-
Menü oder die Tastenkombination Shift+Enter ausführen.

Wenn Sie die Markdown-Zelle ausführen, wird als Ergebnis der formatierte Text angezeigt.

Kleiner Tipp:

Mit Ctrl+Enter wird die Zelle ausgeführt, ohne dass auf die nächste Zelle gesprungen oder eine neue 
Zelle angelegt wird.

Markdown ist eine sehr einfache 
Auszeichnungssprache, um Texte zu 
gestalten. Eine gute Übersicht dazu ist im 
entsprechenden Wikipedia-Artikel zu finden, 
siehe:
https://de.wikipedia.org/wiki/Markdown

https://de.wikipedia.org/wiki/Markdown
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Markdown-Beispiele

Links sehen Sie ein paar typische 
Beispiele für mit Markdown 
formatierte Texte.

Das Ergebnis wird erst nach der 
Ausführung der Zelle (z.B. mit 
Shift+Enter) angezeigt.
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Einschub: Edit- und Command-Mode 

Vielleicht ist es Ihnen schon aufgefallen: Die Zelle, die Sie gerade bearbeiten, bekommt einen 
kleinen blauen Rahmen. Dann befindet sich die Zelle im so genannten Edit-Mode, wobei alle 
Tastatureingaben dem Inhalt der Zelle hinzugefügt werden.

Der Edit-Mode kann durch Drücken der ESC-Taste beendet werden. Dadurch wird in den 
Command-Mode gewechselt, wobei dann alle Tastatureingaben als JupyterLab-Befehle 
interpretiert werden.
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Einschub: Edit- und Command-Mode 

Welche Befehle und entsprechende Tastaturkürzel 
zur Verfügung stehen, können Sie sich durch den 
Aufruf von
View ▸ Activate Command Palette 

anzeigen lassen.

Aufgaben:

Wechseln Sie in den Command-Mode und fügen 
Sie unter der aktuellen Zelle eine neue Zelle über 
das entsprechende Tastaturkürzel hinzu
(siehe Command Palette!).

Wechseln Sie mit dem entsprechenden 
Tastaturkürzel in den Edit-Mode und fügen Sie der 
neuen Zelle einen kurzen, beliebigen Inhalt hinzu.

Löschen Sie die neue Zelle über das 
entsprechende Tastaturkürzel.
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Mathematische Formeln
Mathematische Formeln können in Markdown-Zellen mitten im Text zwischen zwei Dollar-Zeichen als LaTeX-
Formeln eingegeben werden, siehe z.B.: https://en.wikibooks.org/wiki/LaTeX/Mathematics

Soll eine Formel auf einer Zeile allein dargestellt werden, müssen doppelte Dollar-Zeichen verwendet 
werden:

Aufgabe:

Geben Sie eine andere Ihnen 
bekannte Formel in einer 
Markdown-Zelle ein und lassen 
Sie sie durch «Ausführen» der 
Zelle darstellen.

https://en.wikibooks.org/wiki/LaTeX/Mathematics
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Codezellen:

Führen Sie ein paar einfache Python-Befehle einzeln oder gemeinsam 
in verschiedenen Jupyter-Codezellen aus.

Anregungen:

print("Hello, World!")

print(42)

a = 13

a += 2

print(a)



Berner Fachhochschule | Haute école spécialisée bernoise | Bern University of Applied Sciences                                           70

Zellennummerierung
Vor den Codezellen erscheinen sich ständig ändernde Nummern. Diese zeigen die 
Ausführungsreihenfolge der jeweilige Codezellen an:

wurde als 30. Codezelle ausgeführt

wurde als 29. Codezelle ausgeführt
(also vor der oberen Zelle!)

wird soeben ausgeführt

wurde noch nie ausgeführt
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Einschub: Console

Die Console bietet die Möglichkeit, ausserhalb des eigentlichen Notebooks schnell 
und einfach Befehle im gleichen Kernel laufen zu lassen. Die Console kann unter 
anderem über das Menü «File ▸ New Console for Notebook» oder über das 
Kontextmenü (rechte Maustaste) des Notebook-Tabs gestartet werden:
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Einschub: Console

Zusätzlich bietet die Console noch die Möglichkeit, alle im Kernel ausgeführten 
Befehle und deren Ausgeben in ihrer tatsächlichen Reihenfolge zu sehen. Die 
Aktivierung erfolgt via Kontextmenü ▸    «Show All Kernel Activity».

Codezelle für Experimente 
ausserhalb des Notebooks
(Ausführung mit Shift+Enter)
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Aufgabe: Console

Aktivieren Sie die Console und die Ausgabe 
sämtlicher Kernelaktivitäten (siehe vorherige Folie).

Führen Sie sowohl die Codezelle der Console als 
auch Codezellen Ihres Notebooks aus und 
beobachten Sie sowohl die Zellennummerierung 
im Notebook aus auch die Ausgaben in der 
Console.

Tipp:

Die Codezelle am unteren Rad der Console hat eine 
History-Funktion, d.h. wenn die Codezelle leer ist, 
kann man mit den Pfeiltasten (hoch und runter) 
durch die bisher ausgeführten Befehle navigieren 
und diese über diesen Weg auch einfach anpassen 
und erneut ausführen.

Bitte ausprobieren!
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Tipps & Tricks

Durch Drücken der TAB-Taste kann Code 
automatisch vervollständigt werden.

Rechts ein Beispiel, bei dem direkt nach der 
Eingabe des Textes «csv.» die TAB-Taste 
gedrückt wurde. Dann werden alle Methoden 
aus dem csv-Modul angezeigt.

Falls der Code an der Stelle schon eindeutig 
war, z.B. wenn Sie «csv.rea» eingeben und 
dann die TAB-Taste drücken, wird 
automatisch auf «csv.reader» vervollständigt, 
da es die einzige Methode ist, die mit diesem 
Präfix anfängt.

Bitte ausprobieren!
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Tipps & Tricks: Dokumentation

Um aber nicht ständig zwischen Jupyter und 
der Dokumentation im Webbrowser wechseln 
zu müssen, kann man sich die Dokumentation 
eines Moduls oder einer Funktion, auf der der 
Textcursor gerade steht, schnell und direkt mit 
der Tastenkombination Shift-TAB anzeigen 
lassen (rechts das Beispiel für die Funktion 
reader im Modul csv).

Aufgabe:

Lassen Sie sich auf diese Art und Weise die 
Dokumentation des Moduls csv selbst 
anzeigen.

Die Python-Module und ihre Funktionen sind im Allgemeinen sehr gut auf ihren jeweiligen 
Webseiten dokumentiert. Hier nochmal das Beispiel für das Modul csv:  
https://docs.python.org/3/library/csv.html

https://docs.python.org/3/library/csv.html
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Tipps & Tricks: Kontexthilfe

Über das Menü «Help ▸ Show Contextual Help» oder mit der Tastenkombination 

Ctrl+I wird die Kontexthilfe eingeblendet. In diesem Hilfefenster wird 
dynamisch immer die Dokumentation des Moduls oder der Funktion angezeigt, 
in der sich der Textcursor gerade befindet.

(Das Modul oder die Funktion muss jedoch schon mindestens einmal geladen 
worden sein, die Zelle also sicherheitshalber nochmal ausführen.)

Bitte ausprobieren!
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Tipps & Tricks: Scrolling von langen Ausgaben

Es kann vorkommen, dass die 
Ausgabe einer Codezelle sehr lang 
wird. Damit die Übersicht und die 
Navigation im Notebook nicht 
darunter leidet, kann für jede Zelle 
festgelegt werden, ob die Ausgaben 
vollständig oder nur in einem kleinen 
scrollbaren Abschnitt angezeigt 
werden.

Diese Funktion erreicht man über das 
Kontextmenü (rechte Maustaste) einer 
jeden Zelle.
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Tipps & Tricks: Rückgängig / Wiederherstellen

Während man eine Zelle im 
Editiermodus bearbeitet, 
funktionieren die Operationen 
Rückgängig und Wiederherstellen wie in 
jeder üblichen Textverarbeitung über 
die Tastaturkombinationen Ctrl+Z 
und Ctrl+Y.

Im Commandmodus geht es etwas 
schneller mit nur Z und Shift+Z.
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Blender
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Einführung Blender

Zur Erzeugung hochqualitativer 
grafischer Darstellungen von CAD-
Zeichnungen werden darauf 
spezialisierte Programme, sogenannte 
3D-Grafiksuiten, verwendet.

Blender ist eine freie und 
leistungsstarke Software zur 
Erstellung von dreidimensionalen 
Grafiken, Animationen und Spielen, 
siehe:
https://www.blender.org

https://www.blender.org/
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FreeCAD
(optional)
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Einfaches CAD-Programm? → FreeCAD

https://www.freecad.org

https://www.freecad.org/
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CAMPLA / Lernstick
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CAMPLA / Lernstick

● Verwaltungsoberfläche CAMPLA

– Zugriff auf die Prüfung direkt geht leider nur im BFH-Netzwerk...

● Lernstick ohne CAMPLA
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